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 Brushstrokes
MARCH 2024

Forty seven paintings from 36 ar tists have been selected to be in the MasterWorks of New 
Mexico annual Fine Ar ts show. Please join us at the Awards Reception Friday, March 22, from 
5-8 pm.  Awards will be announced at 7.  If you’ve been to this reception before you know it ’s an 
outstanding spread of food and drink.  You get to see old friends, and meet new ones - maybe 
pastel ar tists or oil painters.  Here is an example of some of the watercolors you may see...

“The Tomboy” 
Greg Sorber “Winter Stream” 

 John Cormier

 
“North of the Border”

Mary Perkins

“Peach among Onions”
 Ruth Andrews-Vreeland

“Uber’s Here”
Steve Maize

MasterWorks of New Mexico
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  Prez Sez
ALBUQUERQUE

Recently I’ve been 
toying with the idea of 
how I can take my ar t in 
a new direction. Then 
a funny thing happened 
while my wife and I 
were visiting friends. As 
we were sit ting in their 
home I noticed one of 
my paintings hanging on 
their wall. I was quite 

surprised that they had purchased two of 
my paintings from a gallery that sells my 
work. One of the paintings was of a narrow 
street scene I painted af ter visiting Florence, 
Italy. Our fr iend said she loved the way the 
painting made her feel with all the detail 
and the light and shadow. Interestingly 
the “detail” she was referring to was more 
implied than actual and is a result of the play 
of light and shadow in the painting.

Soon after I came across an ar ticle about 
the late Robert Wade, a well known and 
much admired watercolor ar tist. The ar ticle 
quoted Wade as saying, “…my main concern 
is to create an expression of my emotion 
through light, form, and movement. To be 
able to translate these feelings of excitement 
from my mix of imagination and reality, and 
then put them down on paper, takes much 
intense observation and interpretation. I call 
my process “Perceptive Observation,” which 
I def ine as ‘seeing with your BRAIN, feeling 
with your EYES, interpreting with your 
HEART.’”

This quote captured what I want from my 
own work and what my friend saw in my 
painting. I realize now that I don’t need 
to take my ar t in a “new direction” but 
rather focus on how I can better capture 
“a sensation that will f low through to the 
viewers of my work”.

Tom Cassidy

2023-2024 NMWS President (Albuquerque)

It is nice to know 
that spring is just 
around the corner! 
The promise of longer 
and warmer days 
and the sense of new 
beginnings helps me 
shake of f that winter 
malaise that might be 
best described by a 
quote I saw recently 
that both made me laugh and unfor tunately 
also rang true:

“I’ve been working on it non-star t since 
January”!

It ’s def initely time to f ind some inspiration 
and we are really lucky that the next couple 
of months provides a wealth of opportunities. 
By the time you read this, I will have 
attended the Soon Warren workshop and 
know I will be inspired by what new things 
I learn. It will also be really nice to spend 
3 days painting with other ar tists instead of 
f inding unlimited distractions at home! Other 
workshop opportunities this spring that might 
appeal to you include the Gayle Weisf ield 
workshop in mid-March and the Feeling 
Lin workshop in May, both in Albuquerque. 
There is also another ‘mini workshop’ in Las 
Cruces this month—“Color Play Part 2”.

I also want to make this the year that I try 
more plein-air painting or urban sketching. 
Happily, we have a demonstration planned 
for our March SC meeting that will provide 
some tips. There will be no better time to 
try out those tips than on my planned 2- 
week trip to England this spring—the rolling 
countryside, rocky beaches and coast, 
and moors of Devon are calling. So, here’s 
hoping I won’t have use for that quote any 
more this year.

Karen Steinberg

2023-2024 Southern Chapter President

SOUTHERN CHAPTER
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Albuquerque March 2nd meeting 
“Albuquerque’s Public Arts Program” with Kent Swanson

The city of Albuqueruque has a Ar t in Municipal Places Ordinance that sets 
aside one percent of the city’s budget for the purchase or commission of 
works of ar t. Albuquerque’s Public Ar t Program is tasked with determining a 
site for the ar twork, then identifying a work (or works)  that is in harmony with its surroundings 
and while supporting the community interest. The fruits of this Program can be seen 
thoughout the City with concentrations in the Downtown district, the University/Nob Hill area, 
and historic Old Town.  

Kent Swanson, an ar tist and print-maker (paper sur faces) is the Public Ar t Project 
Coordinator.  At the March meeting Kent will discuss the selection process with an emphasis 
on where a watercolor painting might be best exhibited.  He will also cover the application 
process and show some pictures of current public ar t.  

NMWS Chapter News

Albuquerque 2024 Meeting Schedule
April 6 

May’s meeting is Tuesday, April 30 at 7 pm at 
the Fine Arts Bldg., EXPO New Mexico. This 
will be a demo by Fealing Lin, the featured 

ar tist for the NMWS Spring Show 3-day 
workshop.    

June 8 
July 0 (no meeting) 

August 3 
September 7 

October 5 
November 2 

December 7 (Holiday Party)

Albuquerque’s “Open Studio Day” 
Lyle Brown, Bud Edmondson, Pam 
Hostetler, Pat Leister, and Toni Seidel 
are pleased to announce the return of the 
“Open Studio Day” at The Artist Studio. 
You are invited to view their watercolors 
(as well of those of seven ar tists who 
work in other media) while enjoying light 
refreshments. Sunday, March 3 from 2 
- 4 pm. at The Artist Studio, 8200A & B 
Menaul Blvd. NE, Albuquerque (west end 
of Hoffmantown Shopping Center). We 
apologize for the dif f iculty entering the 
parking lots due to the road construction 
at Wyoming and Menaul. Entering from the 
south side will probably be the easiest.

VOLUNTEERS NEEDED! 

PRESIDENT and TREASURER
The NMWS Nominating Committee is 
searching for several positions including 
President and Treasurer.  If you are 
interested in keeping NMWS running to do 
all the wonder ful things that we do, please 
contact – Andrea Nichols at andien[at]
comcast.net.

Video Editor 
NMWS needs a volunteer with the proper 
software to edit the monthly meeting 
videos into a viewable MP4 format. Barbara 
McGuire will show you how to upload 
the edited video to the NMWS YouTube 
channel. Ideally, the volunteer owns and 
uses a free or low cost video editing 
software program: Free-DaVinci Resolve, 
iMovie or Professional-Final Cut Pro, Power 
Director, or Adobe products. If you are 
intrested please contact Barbara McGuire 
at bmcquire [at]swcp.com or Tom Cassidy at 
tomcassidy45[at]comcast.net. 
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In case you missed the February 3rd talk, 
or want directions, here is the summary 
of how and why you should enter the 
spring show. One of the goals of NMWS 
is to encourage ar tists to develop their 
skills. I believe that entering the show 
helps to support NMWS and all the 
volunteers who work it. We all like to see 
your work and we all learn from each 
other. Entering is a way to challenge 
yourself, gain exposure for your ar t, and 
meet more people with shared interests. I 
hope everyone will enter this one!!

The steps to enter:

1. Select your works. You can enter 3 
standard size and 3 small (less than 80 
square inches) if you want.

2. Take a photo of this in good light to 
accurately see the colors and avoid 
seeing waves in the paper. Try to line up 
three sides with your camera screen.

3. Download the image in actual size to 
your desktop. Save the original image.

4. If you have a photo processor, upload 
the image. If not, download https://www.
gimp.org

a. This is a free photo processor that is   
pretty user fr iendly.

b. The listed commands below are for 
GIMP, but this is similar to other photo 
processors.

5. Rotate your image to be correct. 
(Tools->Transform->Rotate)

6. Crop of f everything but the image. 
(Tools->Transform->Crop)

7. If the colors are not correct, color 
balance the image trying to match the 
painting.

a. (Colors->Color Balance-> [select your 

options])

b. If you need to make white show up as 
white (Color->Auto->White Balance)

8. Scale Image to match requirements 
(Image->Scale Image-> [enter 1920 for 
longest side, and 300 for dbi]->SCALE)

9. Export your edits to your desktop 
(File->Export As -> [newfilename.jpg] -> 
EXPORT)

10. Rename entry for Ar tCall.

11. Login to NMWS. Refer to lef t hand 
column of home screen Events Section 
and click on Spring Exhibition. This takes 
you to Ar tCall.

12. On the ArtCall screen select the 
orange box ‘Register and Apply’

13. If you are new to Ar tCall, set up your 
free account.

14. Enter your data, upload your images, 
pay entry fee with credit card.

15. If you are accepted pay careful 
attention to the framing section of the 
prospectus for directions.

a. You will also need to commit to a time 
to sit the show and volunteer.

b. You will need to drop of f the painting(s) 
between 11 and 1 on the right date, and 
pick up af ter the show.

Don’t be afraid of being declined. It 
happens to us all at some point, including 
world famous talents like Van Gogh, 
Monet, Cezanne, Sisley, and Vermeer. 
These amazing ar tists were repeatedly 
rejected from shows and mostly died 
penniless. If you are afraid to have your 
ar t critiqued, you will never improve. 
Remember being declined is just one 
person’s opinion and in no way ref lects 
your talent, skill, or work.

January Meeting: “How and Why to Enter the Spring 2024 NMWS 
Show” by Sally Harris, NMWS, MD, MS, FAAN Exhibition Chair 



Volume 26, Issue 3, March 2024 5

Southern Chapter

February Meeting
We had another lively and packed meeting for 2024! We had 46 
people in attendance, including 
f ive guests who had learned of us 
from various social media posts, 
calendar listing in Ar t newspaper, 
and friends.

SC Member Pamela Strohbar 
showed us a wide range of 
ir idescent and metallic paints, inks, 
glit ter and more to use to embellish 
our ar twork and take our works in 
progress and play on them to make 

them better! She passed around booklets of the products 
both on black and white paper and showed how to mix and 
use some of them. She answered lots of questions and lef t us 
excited to try out some new products.

To view more images from the demo and a complete list 
with links of the products Pamela discussed, please see our 
Smugmug Page.

March 10th Meeting - “Intro to Plein Air ”
with Nancy Tipton et al 
At our meeting on Sunday, March 10th, Nancy Tipton and our plein 
air group will introduce us to their experiences painting in the great 
outdoors. They will discuss topics such as their hesitancy to begin, tips 
for useful composition, the joy of experimenting with new materials, 
the transition from oils/acrylics to watercolor, the fun and advantages 
of painting small, sketching in public, and encouragement and advice 
from Arlene Tugel (the “pro”) for just getting out there!

Color Play Mini Workshop #2 by Rachel Murphree
Saturday March 16 from 1-4 pm

This workshop is full! 
To get on a waiting list contact Beverley Pirtle at msbevpirtle[at]comcast.net

https://nmwsphotos.smugmug.com/2024/2024-Meetings
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  NMWS (SC) Workshops 

Alcohol Ink Mini Workshop Recap

OOOHHH…..AAAHHHH! Those were the sounds coming from all 
the Alcohol Ink workshop par ticipants as we played and played 
with alcohol inks! It was the best “Paint Therapy” ever, for sure! 
Teacher Kay Gross was highly organized and took us through 
playing on a ceramic tile, to painting on yupo which we could cut 
into pieces or use as a full sheet, and as a f inal surprise, painting 
with the inks onto a frosted glass ball ornament! WOW! Our 
heads were spinning with new ideas on how to use the inks on 
their own, or in combination with watercolors. It was the best way 
to spend three hours on a Saturday with like-minded friends and 
a medium that obeys none of the rules!

Kay shows her painting 
using a combination of 
watercolor, alcohol inks and 
markers.

SC Member Award Winners of FLOA

Cathy Skerker’s “Fanfare” won the People’s Choice award at the SC exhibition.  Laurie 
Churchill and Arlene Tugel also won awards at Ar tForms’ members shows at the 925 
Gallery and the neighboring Duende Gallery.  Laurie’s “Perro Primero” won f irst place and 
Arlene’s “Enchanted Mesa at Whiterock” won second place.  Her painting was done at the 
Los Alamos PAPNM summer event.
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  Paint Outs 

NORTHERN AREA 

by Michael Hill and Joy Hill Brinkley

The March 9th paint out will be at the The March 9th paint out will be at the Valle de Oro National 
Wildlife Refuge and Visitor Center, 7851 2nd Street SW, from 
1 pm to 3 pm. The facility is three miles south of the Rio 
Bravo and 2nd Street SW intersection. There are hiking trails 
with benches, covered areas, a bird pond, and views of the 
Bosque. We look forward to seeing you in March. Please meet 
at the covered breezeway at the visitor ’s center entrance.

SOUTHERN AREA by Nancy Tipton
The March 14th paint out will be from 10:30-12:30 all about 
spring ir ises at the home of Jacqueline Pountney, 4137 Oleta 
Drive (corner of Oleta and O’Hare.) There are ir ises in front of 
Jacqueline’s house and lots in the backyard. She welcomes us 
and says she has two driveways for parking along with street 
parking. She has her f ingers crossed that these ir ises will be 
fully bloomed by our paintout date as they most of ten are, but 
can sometimes bloom later in March, or even early April. If there 
are no blooming ir ises we’ll discuss an alternate paintout plan at 
the March meeting.

The Southern Chapter is currently seeking nominations or 
volunteers for the 2024-25 program year. A slate of of f icers and 
committee chairs will be voted on at our April meeting. Please let 
us know how you can help!

The Southern Chapter Executive Board has 7 voting of f icers: 
President, Vice President /Programs, Secretary, Treasurer, Workshops Chair, Membership 
Chair, and Exhibitions Chair. Off icers meet September-May for 1 hour by Zoom on the 
Saturday before the General Meeting as well as attend most of our meetings. Some of 
our current of f icers have agreed to continue for another year if needed. All would love 
to have someone who could take over a meeting for them now and then! We are in need 
of nominations/volunteers for the following: VP/meeting Program Coordinator, Secretary, 
assistant to the Treasurer, and Exhibitions Chair.

In addition we have standing committees that need additional volunteers to help with 
hospitality (including meeting/workshop greeters), publicity (including photographers and 
posting info to social media sites), exhibitions (intake, hanging, etc.). Committee volunteers 
help of f icers and chairs keep their areas of responsibility running. Let us know if you have 
interest in any of these areas or if you would like to nominate yourself for any of the Off icer 
or Committee Chair roles! If you have questions about roles and responsibilities, or how 
you might help, contact Karen Steinberg at: kjsteinberg[at] aol.com or Rachel Murphree at 
rcmurphree[at]outlook.com.

https://www.fws.gov/refuge/valle-de-oro
https://www.fws.gov/refuge/valle-de-oro
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  Exhibitions

49TH Western Federation of Watercolor Societies 
Exhibition ~March 5-April 29, 2024

Hosted by Arizona Watercolor Association;
at FOUNDRE Hotel, Phoenix
Juror: Stan Miller 
Workshop in Phoenix, March 14-16, 2024

Key Dates For Artists

DEADLINE FOR ONLINE ENTRIES: November 27, 2023

v Details
 u Prospectus Available online = ARTCALL by September 11, 2023
 u Online entry only; deadline: November 27, 2023
 u $50 for up to three entries
 u No Refunds
 u Must be a member of a WFWS Component Society
 u No digital or A.I. art.
 u Minimum painting size: 100 square inches
 u Maximum outside mat size: 30” x 40”
 u Minimum mat width 3.0” on all sides
 u FRAME Size Requirements: Outside mat measurements must be in whole inches and one of the 
  following sizes:16 x 20; 20 x 24; 22 x 22; 30 x 30; 22 x 28; 24 x 30; 24 x 36; 30 x 40
 u Images: .jpg only, 300dpi, Under 4mb, Max of 4600px on longest side
 u Work must be for sale (25% commission deducted from each sale)
 u The artist is responsible for shipping of sold painting.
 u If accepted into the show, there is an additional handling fee of $50, check payable to your Society.

AWA – WFWS#49   Phoenix, AZ

 u The prospectus will be the governing document for determining acceptable entries. You should thorough-
ly review the prospectus prior to entry.  Juried in artists who do not meet the requirements outlined in the 
prospectus are barred from entering for TWO YEARS. Please make sure the accepted entries meet the 
requirements. 

 u Artists will receive email notification of juried in (accepted) paintings by December 13, 2023.

Revised 5/9/2023 tl

Congratulations to the NMWS artists selected 
to be in this year’s Western Fed Exhibition.  
There is a free reception for NMWS delegates 
and ar tists on Thursday, April 18th, and April 
20th is the Gala/Dinner/Dance.  Buy tickets 
HERE. The hotel of fers a WFWS “group 
rate” for slightly less than $269/night. NMWS 
members attending the show during the April 
18-20 time window should let Jay Leutwyler 

and Dave Cook know of their plans, in case any impromptu gatherings are arranged. Click HERE 
to see the show posted on the NMWS website/SmugMug. 

  Calls for Entry

The 2024 NMWS Spring Exhibition is open 
for registration with entries being accepted 
until March 8th.  The opening reception and 
awards ceremony is May 4th from 1-4.  The 
show will run May 4-25 and features both 
standard and small work watercolor and 
water media paintings.  NMWS membership 
is required for entry.  Dues must be paid and 
up to date before submitting to the call for 
entry and remain current throughout the show.                                                         

The standard works juror and judge is 
Fealing Lin, and the small works juror and 
judge is Ruth Andrews-Vreeland. 

Click HERE for the prospectus and to 
register.  

Click HERE to access Ar tcall to submit 
your paintings.  

It ’s VERY Important that 
NMWS members, whether in 
the show or not, take a turn 
sit ting the MasterWorks of 
NM Exhibition. Members will 
function as greeters and will 
NOT have to manage any 
sales transactions. It ’s a time 
to study the ar twork, meet 
other ar tists and greet new 
visitors and friends. It ’s FUN, 
EASY and INSTRUCTIVE. 
Please sign up for a 3.5 shif t 
NOW. Sitters will earn a FREE 
Parking Pass! Click HERE to 
sign up!  And click HERE to 
see the show.  

https://azwatercolor.com/western-federation-of-watercolor-societies/#!event/2024/4/20/awards-presentation-gala-dinner-and-dance
https://nmwsphotos.smugmug.com/2024/2024-Exhibitions/2024-Western-Federation-of-Watercolors
https://nmwatercolorsociety.org/event-5546680
https://nmwsspring24.artcall.org/
https://signup.com/client/invitation2/secure/647008451507786093/false#/invitation
https://nmwsphotos.smugmug.com/2024/2024-Exhibitions/2024-03-MasterWorks-of-NM
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  NMWS Sponsored Workshops
MASTERWORKS 3-DAY WORKSHOP
 “Punch Up the Emotional Story in Your Painting” is the theme for the Gayle 
Weisf ield MasterWorks of NM workshop scheduled for March 26-28, at the 
Hispanic Ar ts Building at EXPO-NM. The workshop is nearly full and is only 
$300 for 3 days of exciting and fun learning. Student seats are limited to 14, 
so don’t delay in signing up. Click HERE for more information and to register. 
Workshop coordinator is Ray Prudhomme at sonnyray76[at]yahoo.com, 
505.296.0273.

Gayle will present a FREE public demo on Tuesday, March 26th at 9:30 AM in the Hispanic Ar ts 
Building. 

2024 Spring Watercolor Workshop 
with Fealing Lin, NWS, TWSA, WW
The annual workshop in conjunction with the NMWS Spring Show will be 
May 1-3 from 9am - 4pm at the Fine Arts Gallery, EXPO New Mexico. 
The cost is $300 due at the time of registration. The workshop is limited 
to 20 students on a “ f irst come, f irst served” basis, with registration 
opening late January to NMWS members, all others in March 2024. Once 
registered, if you cancel, and the workshop is full, you will receive a full refund only if your 
space in the workshop is re-f illed.  Click HERE to register. 

There will be a Public Painting Demo on Tuesday evening, April 30th, star ting at 7PM, in the 
Fine Arts Gallery, EXPO-NM. Admission is $10. Workshop Coordinator is Ray Prudhomme 
505-296-0273

NMWS Gratefully Acknowledges Our “Contributing Members”NMWS Gratefully Acknowledges Our “Contributing Members”  
Tamara Mendoza of the Southern Chapter

NMWS is a 501c3 cer tif ied charitable organization.  All donations are tax deductible.

  Signature News 

CORRECTION: 
Newly inducted Signature 

Master Painter Dave Collis was 
incorrectly listed as Dave Collins in 
the prior newsletter.  Our apologies 

for the error and congratulations 
to Dave for his new status as 

Signature Master Painter. 

SC President Karen Steinberg 
presents Janet McLennan 
with her NMWS Signature 

Member Certificate

https://www.nmwatercolorsociety.org/event-5441014%20
https://nmwatercolorsociety.org/event-5357571
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  Tips n Trix by Kathy Gaither

When you look out at a mountainous terrain 
you know that the land’s contours provide 
the foundation upon which everything grows 
or is built. In the same way, composition 
is the foundation upon which color, 
brushwork, and other elements of our 
painting rest.  Great color, fancy detail, even 
good technique will fail to impress if the 
underlying composition is poor. There is a 
reason for that old expression about putting 
lipstick on a pig.    

Ian Roberts, an ar t professor and oil painter, 
visualizes the role of composition in his 
diagram below that illustrates “Color gets all 
the credit,” reminding us that color is only 
as ef fective as the foundational plan that 
put it there. His You Tube video “Painting is 
Seeing in Shapes” is good for any medium.

My simplif ication of composition for early 
learners is to focus on the goals of good 
composition. Formal terms for elements and 
principles are brought in as examples of how 
to get to the goals. A shor t beginner goals 
list follows:

1. Keep the main thing the main thing. 
Write out specif ics about “Why” you’re 
presenting this picture and “Where” you 
want the viewer to pay the most attention.  
Edit /crop/reorganize your resource to focus 
more on conveying the concept than on 
reproducing reality. Don’t make the main 
thing too small,but do make it the most 
interesting area. 

2. Place the Center of Interest of f center 
by dividing the picture plane into thirds  

horizontally 
and ver tically, 
placing the 
center of 
interest at or 
near one of the 
intersections of 
the grid lines. 

3. Make the 
foundation 
large, 
interesting shapes in a strong abstract 
design.  Look behind the detail for  large 
shapes like a mass of trees, or the overall 
outline of a group of objects, or shapes 
made by strong lines like diagonals, 
ver ticals or horizontals. My kingbird painting 
has large rectangular shapes supporting a 
cruciform design.  See Liron Yanconsky’s 
You Tube “Watercolor Composition 
Demonstration - Painting Large Shapes.”

4.Ensure dominance in all design 
elements (color, line, value, etc.):  Use a 
limited palette with color, temperature and 
intensity dominance. Use enough big value 
shapes to hold things together avoid the 
distraction busyness.

5.Never make any two intervals the 
same. The Simple Secret to Better Painting 
by Greg Alber t illustrates this rule of 
composition which tells you don’t line up 
trees, still life objects, or people in a crowd 
like neatly spaced fence posts.  Don’t make 
objects in a group all look the same.  This 
extends to using variety in spacing out 
values, textures, etc. and is key to another 
idea.   Don’t be boring.Don’t be boring. Don’t have large 
areas of the picture with nothing useful or 
interesting going on (crop!)  Try painting 
unusual subjects like a f ire hydrant, or with 
common subjects try an unusual point of 
view or non-realistic color. Step out from 
using other people’s resource. Create your 
own view.  

Remember if you’re a beginner and you’re 
on the path, all you need is time to learn to 
build strong compositions. 

https://www.ianroberts.com
https://www.bing.com/videos/riverview/relatedvideo?q=painting+is+seeing+in+shapes+you+tube&mid=53085D54F466E9A4AEEE53085D54F466E9A4AEEE&FORM=VIRE
https://www.bing.com/videos/riverview/relatedvideo?q=painting+is+seeing+in+shapes+you+tube&mid=53085D54F466E9A4AEEE53085D54F466E9A4AEEE&FORM=VIRE
https://youtu.be/C8RTh0Khkto
https://youtu.be/C8RTh0Khkto
https://www.amazon.com/Simple-Secret-Better-Painting/dp/1635619734
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PLEASE CONTRIBUTE TO THE APRIL 
ISSUE OF BRUSHSTROKES

Please send news items, accomplishments 
and other contributions to  

ctrotter [at] unm.edu

The information is due by MARCH 15

Caryl Trotter, Your Brushstrokes Editor

WHO WE ARE & WHAT WE’RE ABOUT 

The New Mexico Watercolor Society (NMWS)
was founded in 1969 as a statewide chapter of the 
Southwestern Watercolor Society of Dal las, TX. In 
January 1970, the NMWS became an independent 
entity with 501(c)(3) status.

OUR VISION:  To Inspire a Passion for 
Watercolor Art

OUR MISSION:  We wil l accomplish our Vision 
through support of the highest  aesthetic standards 
in quality and presentation of art , education of 
the public regarding watercolor art , promotion of 
community engagement, faci l itat ion of member 
art ist ic development through workshops, demos, 
etc.

PAPER SALES (not available at Southern Chapter)

Ray Prudhomme sells watercolor paper at the 
meetings or by appointment at 505-296-0273 or 
raynjan1969[at]yahoo.com.  CHECKS ONLY
Prices (subject to change):
Arches 140 lb. Cold/Hot Press, Rough		 $ 8
Arches 300 lb. Cold/Hot Press, Rough,	 $17
Fabriano Artistico 140 lb. Bright White		 $ 7
Yupo 72 lb. White					     $ 5 
Yupo 144 lb. White					    $ 6
Special order/special request watercolor paper:
Fabriano 140 lb. Cold Press			   $ 7
Fabriano 300 lb. Bright White Soft Press	 $14
Saunders Water ford 140 lb. Cold Press	 $10

NMWS OFFICERS
ALBUQUERQUE BOARD OF DIRECTORS

Strategic Leadership 2023-2024 

Chairperson of the Board:  Barbara McGuire
Vice-Chair of the Board:  Rachel Murphree
President: Tom Cassidy
Immediate Past President:  Barbara McGuire
Secretary: Traci Durgin
Treasurer:  Dorothy Brockman
Membership Chair:  Shelly Brown
Satellite President:  Karen Steinberg
Members at Large: John Cormier & Lonnie Shan 

EXECUTIVE COMMITTEE: Tactical Leadership
President: Tom Cassidy
VP/Programs Chair:  Sarita Bedge
Secretary: Traci Durgin
Treasurer:  Dorothy Brockman
Membership, Shelly Brown
Exhibitions: Sally Harris
Publicity:  Steve Webb & Mary Quirolo
Jim Terry, Facilit ies
Immediate Past President:  Barbara McGuire

LAS CRUCES - SOUTHERN CHAPTER
EXECUTIVE BOARD 2023-2024

President - Karen Steinberg
Vice President - Rachel Murphree
Secretary - Karin Hayes
Treasurer - Rob Sheldon
Membership - Georgia Young
Exhibitions - Laurel Weathersbee
Workshops - Karin Hayes
Past President - Rachel Murphree

For contact information and other of f icers, please 
see website at nmwatercolorsociety.org 

  And Everything Else......

OUR COMMON CORE VALUES                    
1:  Ar tistic Development Through Education
2:  Par ticipation and Volunteerism
3:  Community Presence
4:  Organizational Sustainability
5:  Welcoming Culture 

See the website for more details on these 
core values. NMWS Signature Member status 
is attained when a NMWS member in good 
standing has been accepted in f ive “eligible” 
NMWS juried shows within f ive years. Click 
HERE for more information.   The NMWS 
is a member of the Western Federation of 
Watercolor Societies (WFWS).

https://nmwatercolorsociety.org/NM-Watercolor-Society-Vision-&-Mission-Statements
https://nmwatercolorsociety.org/Signature-Member-Group

